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Learning Objectives 
At the end of this class, you will be able to: 

• Access data from a geographic information system database to use for preliminary design in 
AutoCAD Civil 3D software 

• Stylize geographic information system data for use in preliminary design 

• Create AutoCAD Civil 3D software surfaces and pipe data from geographic information system data 

• Complete the workflow by exporting AutoCAD Civil 3D software data back to geographic information 
system 

About the Speakers 

Michael Gardner is the AutoCAD Coordinator for Freese and Nichols Inc. (FNI), an 

engineering and architectural firm located in Fort Worth, Texas. Certified in AutoCAD and 

AutoCAD Civil 3D software, he has over 35 years of drafting and CAD experience. As the CAD 

manager for various firms, Michael has provided user support, developed corporate CAD 

standards, and created customized training. He also has offered contract services through his 

own firm. Michael draws from over 20 years of teaching experience to provide custom material 

and training through Freese and Nichols University, the training arm of FNI. 

Mark Valentino is the GIS Coordinator for Freese and Nichols, Inc. Mark is an ESRI Certified 

ArcGIS Desktop Professional and ESRI Certified Enterprise Administration Associate 

Eddie Johnson is an ENI Technical Specialist for Construction Industry Solutions (COINS) in 

Dallas-Fort Worth.  He is an Autodesk Certified Instructor, Certified Autodesk Product Support 

Specialist and Autodesk Infrastructure Design Suite Certified BIM Specialist focusing on the 

products in the Infrastructure Design Suite.  With 25 years of Industry experience, 17 of which 

was as a designer, CAD Manager and Production Manager, he leverages this knowledge to 

maximize his clients’ productivity and ROI through training/support, consulting and various 

professional services. 

Eddie was a highly rated speaker at Autodesk University 2009 and AUGI CAD Camp in 2010. 
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About the Companies 

Freese and Nichols, Inc. is a full-service professional consulting firm and the first 

engineering/architecture firm to receive the Malcolm Baldrige National Quality Award.  The firm 

was started by John Hawley in 1894, making this year our 120th Anniversary.  Hawley was 

Texas’ first independent consulting engineer for water and sewer work. 

With offices in Texas and North Carolina, Freese and Nichols provides services in:  

• Engineering 

• Architecture 

• Construction services 

• Planning 

• Energy 

• Program management  

 

Construction Industry Solutions (COINS) is a leading provider of Autodesk design and 

engineering solutions to the building, architecture, mechanical, civil engineering, geospatial, 

and construction industries. We are also a market-leading, construction-industry software 

solutions company providing innovative ERP business software and savvy solutions for top 

construction and service businesses around the world. We are a global company with a strong 

presence in the USA, UK, Ireland, Australia, and Asia. 

 

 

 

 

 

The Disclaimer! 

The information included in this document is not intended to be an all-round primer for GIS and 

coordinate systems.  If you would like more information on coordinate systems and GIS then the 

following sites may be of interest to you: 

• http://www.esri.com/ 

• http://www.usgs.gov/ 

• http://www.webgis.com/usgsseam.html 

• http://data.geocomm.com/ 
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GIS Overview 

A geographic information system (GIS) captures, stores, analyzes, manages, and presents data 

that is linked to location. Technically, GIS is geographic information systems which includes 

mapping software and its application with remote sensing, land surveying, aerial photography, 

mathematics, photogrammetry, geography, and tools that can be implemented with GIS 

software. Still, many refer to "geographic information system" as GIS even though it doesn't 

cover all tools connected to topology.  It is a transformational technology and method. 

GIS as defined by www.esri.com/what-is-gis: 

• GIS lets us visualize, question, analyze, interpret, and understand data to reveal 

relationships, patterns, and trends 

• GIS integrates hardware, software, and data for capturing, managing, analyzing, and 

displaying all forms of geographically referenced information 

• GIS allows us to view, understand, question, interpret, and visualize data in many ways 

that reveal relationships, patterns, and trends in the form of maps, globes, reports, and 

charts 

• GIS helps you answer questions and solve problems by looking at your data in a way 

that is quickly understood and easily shared. 

• GIS technology can be integrated into any enterprise information system framework 
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CAD/GIS Integration 

In many ways CAD and GIS are like oil and water.  CAD data is very precise with accurate 

measurements whereas GIS tends to be neither of these (however it can be as will be 

discussed later).  GIS data is typically worked in very large scale, cartographic in nature and not 

pure engineering.  However it is this magnitude of scale that makes it a valuable tool for CAD 

users.  Although current GIS data may not be accurate to CAD standards, the data is useful in 

preparing early prototype designs before the effort is expended to retrieve more accurate data. 

In short, GIS gives the CAD user access to readily available data that can be used to prepare a 

design evaluation or begin a preliminary design with little or no extra cost or effort.  This early 

design effort many times will yield information that will aid in collecting more accurate site data 

and allow the engineer to expend less time and effort getting the data needed for a final design. 

Routing a pipeline is a good example of using GIS data for preliminary design.  It allows the 

engineer to use aerial data and topography to identify structures, roads, creeks and other 

obstacles that may impede the alignment desired.  Property line information may be added to 

help ‘fine tune’ the alignment for obtaining easement information.  Once this preliminary design 

is complete, then the survey work may begin with a more defined path for collection than might 

have been available without the GIS information. 
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Preparing CAD to receive GIS data 

GIS data is spatial meaning ‘of or related to space.’  This means that where in the world the 

data is located is just as important as what the data is. In order to prepare CAD to receive GIS 

data located correctly we need to take a look at Coordinate Systems and what they mean. 

Coordinate System Basics 

Simply put, a coordinate system is just a reference system with specified datum (horizontal and 

vertical location relative to a specific location) and projection (mathematical model used to 

transform the curved surface of the earth to a planar representation). Standard coordinate 

systems use particular projections over zones of the earth’s surface. Each zone then has a 

specified origin. 

There are three distinct types of coordinate system: 

• Geographic – global or spherical system such as Latitude-Longitude 

 

• Projected – Also known as “Grid”, utilizes localized zones for higher accuracy on the 

ground. (State Plane Coordinates fall in to this category.) 
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• Global Cartesian – Provides coordinates for the whole earth. GPS uses this system 

Each Coordinate System is defined by the following: 

• Measurement Framework which is Geographic (spherical coordinates are measured 

from the earth’s center) or Planimetric (earth’s coordinates are projected onto a two-

dimensional planar surface) 

• Unit of Measurement (Feet, Meters or Decimal degrees) 

• For Projected Systems, the definition of the map projection 

• Other measurement system properties such as a datum or spheroid of reference and 

projection parameters 

Grid to Ground 

Measuring distances between two points varies dependent upon the coordinate system in use.  

Typically measurements over short distances (less than a mile) are measured along the ground 

and are thus understood to be Ground measurements.  However when dealing with the vast 

distance inherit in GIS data the accuracy of ground measurements become difficult to maintain.  

Therefore most GIS data is measured in Grid. Let’s look at what the difference is between 

Ground and Grid using the following diagram: 
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• Ground - Earth Surface consisting of Horizontal distances, elevations and angles 

• Ground Distance – Distance (horizontal distance and curvature applied) between two 

ground points 

• Ellipsoid - Mathematically smoothed surface of the earth by averaging the high and low 

points 

• Geodetic Distance – The length of the shortest curve between those two points along 

the surface of the earth model being used by the spatial reference system 

• Grid Plane - A grid is a two-dimensional horizontal rectangular coordinate system 

• Grid Distance – The distance between two points that is expressed in mapping 

projection coordinates 

Setting Coordinate System 

In order to accurately locate the data coming from GIS it is important to set the desired 

coordinate system for the working area.  Typically the State Plane Coordinates are used in CAD 

design files.  To assign the desired coordinate value set the workspace to Planning and 

Analysis and select Assign from the Map Setup tab in the ribbon menu. 
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The Coordinate System Assign window gives you access to a vast number of coordinate 

systems around the world.  You may shorten the list by entering some part of the name for the 

coordinate system you desire in the Search box.  Next, scroll to and select the desired 

coordinate system. 
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Attaching GIS Data in AutoCAD Civil 3D 

Map 3D enables users to not only import from a wide array of data formats but allows 

connection to data in their original sources 

and save changes in the native format or 

convert the data to DWG format, breaking 

any connection to the original source 

With the coordinate system set we are ready 

to bring GIS data in to our CAD file.  You 

may insert either a data file or raster image 

into your drawing or create a database 

connection.  The icon for inserting these files 

is Connect located on the Home tab of the 

ribbon menu on the Planning and Analysis 

workspace.  Alternatively the icon Data may 

be accessed from the top of the TASK 

PANE.  

Data Connect 

Following are some of the methods you can use to insert GIS data in to your CAD file. 

Add ArcSDE Connection 

If you use SQL Server or Oracle you can use either Windows or ArcSDE authentication.  

• Select the feature classes to include in your map.  

• Style, theme, and edit the features. 

• Bring in a static copy of ArcSDE data as drawing objects. 

Add Raster Image or Surface Connection 

Connecting to raster data as opposed to inserting the image has advantages: 

• Faster Performance 

• When panning and zooming only the image in current view regens 

• Raster formats supported: .DEM, .JPG, .JPG2, .ECW, .SID, .TIF, .PNG 

• Raster enablers are not needed to connect to ECW or SID files 

Add SDF Connection (Spatial Data File) 

A Spatial Data File (SDF) is a native Autodesk file-based geospatial format that is optimized for 

storing large, classified data sets. The SDF format is similar to the SHP format in that if contains 

both spatial data and attribute data.  However it accomplishes this in a single file rather than a 

set of files. 

The SDF file has certain advantages to the SHP in the following ways: 
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• It stores and manages an order of magnitude more data than DWG  

• It is very fast, allowing Autodesk applications, such as AutoCAD Map 3D and Map 

Server, to read and display tens of thousands of features per second.  

• It provides the power of a database without the overhead and cost of a full relational 

database management system (RDBMS) such as SQL Server or Oracle.  

• An SDF file can store a single feature class, or it can store multiple feature classes.  

• It is easy to manage, providing access to the database schema. 

Add SHP Connection (Shape Files) 

A Shape File (SHP) is a digital vector storage format for storing geometric location and 

associated attribute information. The SHP format was introduced with ArcView GIS version 2 in 

the beginning of the 1990s. It is now possible to read and write SHP using a variety of free and 

non-free programs. With MAP 3D you can either insert a SHP into your drawing or create a 

database connection. 

Select the feature classes to include in your map.  

• Style, theme, and edit the features.  

• Lock the file when you connect to it. 

An individual SHP is actually a collection of files as described above that must be moved or 

distributed as a group otherwise the SHP can be rendered unusable. 

• .SHP – Shape format (file that stores the feature geometry ) 

• .SHX – Shape Index format (file that stores the index of the 

feature geometry) 

• .DBF – dBASE file that stores the attribute information of 

features 

• .PRJ – File that stores the coordinate system 

• .SBN and .SBX - files that store the spatial index of the 

features (optional) 

• .FBN and .FBX - files that store the spatial index of the 

features for SHP that are read-only (optional) 

• .AIN and .AIH - files that store the attribute index of the 

active fields in a table or a theme's attribute table (optional) 
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Add WFS Data (Web Feature Service - web-based vector features service) 

Select the feature classes to include in your map. 

• Reproject the data to the coordinate system of your map. 

• Style and theme features. You cannot edit features from a WFS data source. 

  

Add WMS Data (Web Map Service – web-based raster image data service) 

Select the feature classes to include in your map. 
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Stylize GIS Data 

When you add GIS data a default set of styles are applied to the objects.  You will likely wish to 

modify or change these styles to fit your standards or specific needs.  CAD data is typically 

modified by changing colors, line types or layers to obtain the desired look.  GIS data has a 

different set of tools for modifying the look and feel.  These tools can be found on the TASK 

PANE in the Planning and Analysis workspace.  The TASK PANE may be accessed while in the 

AutoCAD Civil 3D workspace by using the MAPWSPACE command and setting it to ON. 

 

TASK PANE 

The TASK PANE in the Planning and Analysis workspace serves a similar purpose to the 

TOOLSPACE in the AutoCAD Civil 3D workspace.  From here the user has the ability to modify 

or Style the various components and control the order of display, moving certain features in 

front or behind other features. 

The TASK PANE has a group of icons at the top used to edit and modify the GIS data in 

addition to four tabs. 

• Display Manager – Manage Features stored in data stores, attach drawing files and 

change the appearance of features. Each feature is a layer and drawing layers can be 

added as well. 

• Map Explorer – View the elements of your Map Project. Such elements include files 

connected to as sources, queries used and saved and templates for linking drawing 

objects to data. 

• Map Book – Divide a large map into “tiles”. Each tile is rendered on a separate page. 

Publish in various formats for printing and online display 

• Survey – Bring in and work with Survey Point Data 
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Styling 

From the Display Manager Tab the user has control of the 

display order of the items by moving them up or down the 

list to move the items from front to back (top to the front 

and bottom to the back) of the CAD file. 

To modify the color or line type of the attached GIS data, 

highlight the item to be modified in the list and select the 

Style icon near the top of the TASK PANE.  The Style 

Editor window will open giving you access to all of the 

modification and label tools.  From here colors, line weights 

and styles, transparency and labels can be set for each of 

the GIS data items. 
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Creating AutoCAD Civil 3D Objects from GIS Data 

With the GIS data attached to our CD file, it’s time to begin converting that data to be useable 

as a part of our AutoCAD Civil 3D design set.  We will 

look at two processes, creating a surface and creating 

pipe networks from existing data. 

Create a Surface 

One of the more basic uses of GIS data is to bring 

surface information in to AutoCAD Civil 3D.  This may 

well be the simplest process of all.  Data for creating a 

surface can be obtained either from a live connection 

such as an ESRI database or from a SHP.  The SHP file 

does not need to be connected to your CAD file to be 

used for surface creation. 

 

 

 

Be certain to determine which property in the SHP contains the 

elevation data to be used for creating the surface.  One simple 

way is to attach the SHP, highlight one of the contour lines and 

select Properties.  From the Properties window a list of the 

properties will appear that are a part of the SHP and allow you to 

determine which one has the needed value for contour 

elevations. 

 

  

 

 

Create Pipe Networks from Existing Pipe Data 

In addition to surface data, Pipe Networks can be created from GIS data, assuming the data 

contains all the necessary ingredients. Unfortunately not all of the data related to pipes has all 

the information necessary to create a Pipe Network. Properties that are needed for pipe include: 

• Geometry (Created with the SHP) 

• Pipe Size (Inner Diameter) 

• Starting Elevation (Invert In) 
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• Ending Elevation (Invert Out) 

• Material (PVC, HDPE, etc.) 

In like manner, certain properties are needed when defining structures such as manway or 

junction boxes: 

• Geometry (Created with the SHP) 

• Rim Elevation 

• Sump Elevation 

Import GIS Data 

The process of creating a Pipe Network from GIS 

data starts under the Import section on the Insert 

tab of the AutoCAD Civil 3D Ribbon menu. 

The Import GIS Data window will open allowing you 

to select a single SHP or a folder containing several 

SHP.  Selecting a folder is convenient for importing 

both pipe and structures at one time and having them connected once imported. Remember 

that the SHP can only contain one type of object so at least two SHP are needed to import both 

pipe and structures.  A network name, pipe list, pipe and structure labels are selected through 

this process. 

Once the pipe and structure properties are assigned, the pipe network will be available in the 

AutoCAD Civil 3D design file. 
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Export AutoCAD Civil 3D Design Data to GIS 

Each completed AutoCAD Civil 3D project contains data that can be reused or shared for 

additional projects.  Typically this data is stored as AutoCAD Civil 3D files and then later 

attempts to extract this information in a newer version of software becomes cumbersome at 

best.  What if that data could be stored in a convenient package that could be extracted and 

used at a later time without concern over the version or even brand of software being used?  

GIS gives us that ability to store data that can be readily used regardless of the version or file 

type needed. 

 

How Do We Share Civil Data 

There are a number of ways to transfer AutoCAD C3D data to GIS.  First you must determine 

what information and how detailed that information must be in order to determine the process 

needed. Following is a list of commands that will allow you to 

generate GIS friendly data: 

Extract Contour Data 

An existing AutoCAD Civil 3D surface may be used to extract data 

directly to a SHP for use in GIS.  The Extract Objects icon is located 

on the context ribbon menu that appears when the surface is 

highlighted.  Once executed the contours are selected and using 

MAPEXPORT the appropriate data is selected and a SHP is 

created.  
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Export AutoCAD Civil 3D Objects to SDF 

Exporting AutoCAD Civil 3D objects to SDF is similar to extracting data for SHP.  Advantages of 

using SDF is that all the data is stored in one file and that multiple data types may be included in 

the single SDF. The only problem is that GIS will not read an SDF and the data must then be 

converted to SHP.  There are four types of AutoCAD Civil 3D Data that can be exported to SDF: 

• Alignments 

• Points 

• Parcels 

• Pipe Network Data 

MAPEXPORT 

The MAPEXPORT 

command is used in conjunction with the Extract Objects or the Export Civil Objects to SDF to 

generate the particular file type containing the desired information. 

Bulk Copy 

Bulk Copy is available under the Tools icon when the Map Explorer tab is selected in the TASK 

PANE.  It gives you the ability to copy selected feature items from the current drawing to a SHP 

or SDF.  

Bulk Copy can also be used to copy SDF data in to a SHP for use by GIS.  When selecting 

items to copy from the source SDF there are some restrictions for the target name: 

• SHP will not accept special characters 

in the name (i.e., \, /, - , _, etc.) 

• Name length must be 12 characters or 

less 
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Storm and Sanitary Analysis (SSA) 

Exporting Pipe Networks from Civil 

3D to GIS as an SDF is easy 

however the exported attributes are 

limited.  This limitation creates the 

need for another process that allows 

for additional attributes to be 

collected and sent to GIS.  

The Storm and Sanitary Analysis 

program allows the user to extract 

data from Civil 3D objects (namely 

pipes and structures) and export 

them to GIS with more attribute 

information than a simple SDF.  Interoperability with AutoCAD Civil 3D makes it a simple 

process to export your Pipe Network data to SSA. 

Begin the process by verifying the Part Matching defaults.  This is found on the Tool Space 

Settings tab.  Expand Pipe Network > Commands > EditInSSA 



Follow the GIS Brick Road 

19 
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Exporting the Pipe Network is handled from the Analyze tab in the ribbon menu and selecting 

Edit in Storm and Sanitary Analysis.  

Select the Pipe Networks to be included and create a New Project when SSA launches. 

Inspect the imported pipes and structures and make ant necessary adjustments.  When 

satisfied that Pipe Network is ready for export select File > Export > GIS Export.  

 

Select Next and define the SHP directory path 
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Select Element Types, pipes and junctions (structures) 

 

Next select the Field Definitions to be exported to the SHP.  The information available will vary 

depending on the type of Element(s) selected. 
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Click finish and the data will be exported to the SHP and the folder designated. 

 

The created SHP are now available to be imported to GIS and return to the beginning! 

 

 MGM Studios – The Wizard of Oz 


